3. Čas – Microsoft Excel (Uvod)
3.1 Podešavanje okruženja i upravljanje podacima
Podešavanje okruženja
Na slici 29 prikazano je okruženje u excel-u, kao i neki osnovni pojmovi kao što su redovi, kolone, ćelije i listovi.
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Slika 29

Tri važne i korisne opcije su:
1) Microsoft Office dugme
2) Traka sa alatkama
3) Traka sa brzim pristupom alatima

Klikom na Microsoft Office dugme korisniku je ponudjen niz opcija kao što su: da napravi novi
dokument, otvori postojeći dokument, kao i da sačuva, odštampa, pošalje ili zatvori trenutni dokument.
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 (
Metodika nastave računarstva A
)


Dodatno, Excel nudi širok spektar prilagodljivih opcija koje omogućavaju korisniku da sam sebi prilagodi i olakša rad sa ovim programom. Do ovih opcija se dolazi klikom na Office dugme a zatim na Excel opcije.
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U ovim opcijama možete pronaći opcije kao sto su:
· Popular - omogućavaju korisniku da personalizuje svoje radno okruženje sa mini barom sa alatkama, šemom boja, opcijama za nove radove i slično.
· Formulas - omogućava korisniku da izmeni podešavanja koja se odnose na rad sa formulama.
· Proofing - omogućava korisniku da promeni podešavanja koja se odnose na automatsko ispravljanje grešaka u tekstu, kao i na proveru spelovanja.
· Save - omogućava korisniku promeni način na koji će dokument biti sačuvan. Ovde je moguće podesiti i period na koji će se rad automatki sačuvati, kao i podrazumevanu lokaciju za čuvanje dokumenta.
· Advanced - omogućava korisniku da podesi opcije za uređivanje, kopiranje, nalepljivanje, štampanje i prikazovanje formula.
· Customize - omogućava korisniku da doda razne druge opcije na meni sa brzim pristupom. Ovde se obično smeštaju opcije koje se često koriste.

Traka sa alatkama
Traka je panel na gornjem delu dokumenta koji ima 7 kartica : Home, Insert, Page Layout, Formulas, Data, Review i View. Svaka kartica je podeljena u grupe (srodnih opcija).


[image: ]
Unutar svake od ovih kartica nalaze se najčešće korišćene opcije, podeljene u više grupa. Dodatne opcije se mogu videti klikom na strelicu u donjem desnom uglu svake od ovih grupa.
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Upravljanje podacima


1. Pravljenje novog dokumenta
· Microsoft Office dugme  New  Blank Document
2. Čuvanje dokumenta
· Microsoft Office dugme  Save
3. Otvaranje postojećeg dokumenta
· Microsoft Office dugme  Open
Formula bar
Jedna od najčešće korišćenih stvari u Excel-u je mesto za unos formula (eng. Formula bar), gde pišemo funkcije koje se izvršavaju nad ćelijama Excel dokumenta.
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3.2 Upravljanje podacima, rad sa listovima

Excel nam omogućava da premestimo, kopiramo i nalepimo ćelije i sadržaje ćelija korišćenjem naredbe cut i paste kao i copy i paste.

Označavanje ćelija
Označavanje ćelija i sadržaja ćelija za kopiranje ili sečenje radi se na sledeći način:
· Za jednu ćeliju: samo jednim klikom
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· Za više ćelija: klikom, a zatim prevlačenjem miša
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Označavanje reda ili kolone

Označavanje se vrši klikom na broj reda, odnosno klikom na zaglavlje kolone.
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Automatsko popunjavanje (Auto Fill)
Ako želite da imate niz podataka (na primer dani u nedelji) popunite prve dve ćelije u seriji a onda koristite funkciju automatskog popunjavanja. Da biste koristili funkciju automatsko popunjavanje:
· Kliknete na ćošak ćelije
· Prevlačite taj ćošak da popunite ostale ćelije
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Ubacivanje ćelija, reda i vrste/kolone
· Za ubacivanje ćelije, reda i vrste:
· Postavite kursor u redu ispod meste gde želite novi red, ili u koloni sa leve strane gde želite novu kolonu
· Kliknite na Insert u grupi ćelija na Home kartici
· Kliknite na odgovarajući izbor: ćelija(Cell) , red(Row) ili kolona(Column)
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Brisanje ćelija, reda i vrste/kolone
Za brisanje ćelije, reda i vrste:
· Postavite kursor u ćeliju, red ili vrstu koju želite da izbrišete
· Kliknete na Delete u grupi ćelija na Home kartici
· Kliknite na odgovarajući izbor: ćelija(Cell) , red(Row) ili kolona(Column)
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Pronalaženje i menjanje (Find and Replace)
Za pronalaženje i menjanje podataka:
· Kliknete na Find & Select u grupi Editing na Home kartici
· Izaberite pronalaženje(Find) ili menjanje(Replace)
· Popunite polja u Find What polju
· Kliknite na opcije(Options) za više pretraživanja opcija
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3.3. Izračunavanja
Direktnim upisivanjem
Ovaj nacin je najzahtevniji, jer pretpostavlja da znate sintaksu formule. Recimo da zelimo izracunati aritmeticku sredinu brojcanih podataka upisanih u polja A1 do A5, i da rezultat bude u polju C6.
Kliknemo na C6 i upisemo =AVERAGE(A1:A5) te pritisnemo Enter.
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Koriscenjem opcije za umetanje formule
Kliknite na polje C6 u koje zelite upisati formulu. Izaberite Insert/Function i zatim pronadjete funkciju
«AVERAGE» te pritisnite «OK»:
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Rezultat je sada upisan u polje C6.

VAZNA NAPOMENA: Primetimo da je polje C6 sada vezano uz polja A1 do A5 na sledeci nacin: ako promenimo jednu ili vise vrednosti u poljima A1 do A5 i vrednost u polju C6 ce se promeniti, jer ona zavisi od polja A1 do A5.

Opcija “Help on this function”
Ako ne razumete u potpunosti koje argumente pojedina funkcija koristi, ili ne znate tacno sta ce biti
rezultat , ili kako se taj rezultat dobija, mozete koristiti «Help on this function» . Na primer, za funkciju AVERAGE pritisnimo «Help on this function».Na kraju objasnjenja se dobija I primer:






Apsolutne, relativne i mešovite reference
Excel omogucava da lako kopiramo i prevlacimo formule iz celije u celiju. Prilikom tog prevlacenja mogu se promeniti reference ka odredjenim celijama, sto nam uglavnom odgovara ali ne uvek. Pokazacemo Vam kako mozete da kontrolisete tu promenu. Pre svega je bitno da razlikujete koncepte apsolutnih i
relativnih referenci ćelija u formulama.
Kako prevlacimo formulu, tako se i reference ka celijama menjaju. Na primer, ako gore pomenutu formulu sa polja C6 prevučemo u ćeliju C7, ona ce uzimati vrednosti sume(B1: B5).
Medjutim, nije nam uvek to potrebno. Neke vrednosti mogu biti fiksirane u formuli, bez obzira na kopiranje.Fiksiranje radimo tako sto pored reda i kolone stavimo znak za dolar. Umesto A2, na primer, stajace $A$2. Znak govori da se vrednost nikada ne menja ma gde god kopirali ili prevukli formulu.
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Mesovite reference - Omogućava da fiksiramo samo red ili samo kolonu. Na primer, u formuli "=(A$1 +
$B2)" je fiksirana prva kolona reda A i fikciran je red B, a kolona moze da se menja.

3. 4 Makroi
Makroi se koriste u situacijama kada neke elemente često koristimo. Oni ubrzavaju rad tako što kad jednom snimimo neke naše izmene (formatiranja, editovanja.. ), te akcije možemo ponoviti korišćenjem makroa u samo jednom koraku.

Snimanje makroa

Slično kao u Word-u. Odaberemo opciju View → Macros → Record Macro… U prozoru koji se otvara (Slika 1), treba uneti ime makroa, kao i prečicu sa tastature kojom ćemo kasnije pokretati makro. Treba voditi računa da se ne odabere neka prečica koja već postoji, a važna nam je (npr. Ctrl+c, Ctrl+v…), jer će je prečica za makro prevazići. Klinemo Ok.
Od ovog trenutka sve naše izmene će biti snimljene. Kada napravimo željeni makro, zaustavljamo snimanje opcijom View → Macros → Stop Recording.
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Slika 13	Slika 12

Pokretanje makroa

Makro se jednostavno pokreće korišćenjem prečice sa tastature koju smo zadali prilikom njegovog kreiranja. Drugi način: View → Macros →View Macros, zatim odaberemo makro koji želimo da pokrenemo i kliknemo Run. To je ilustrovano na Slici 2.

3.5 Sortiranje i filtriranje podataka
Sortiranje podataka
1. Prvo je potrebno da označimo SVE podatke koje zelimo da sortiramo (a ne samo kolonu po kojoj sortiramo podatke).
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Ako to ne uradimo, moze se desiti da podaci budu pogresno sortirani i izmesani.
2. Pritom kliknemo na Home pa na Sort & Filter
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Ovde vidimo da imamo neka najćešće korišćena sotrtiranja (leksikografski rastuće i opadajuće). Ukoliko želimo neko drugačije sortiranje, potrebno je da kliknemo na dugme Custom Sort i pojavice nam se:
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3. Izabrati kolonu po kojoj želimo da sortiramo podatke

Ovde možemo izabrati način sortiranja, kao i uređenje (rastuće ili opadajuće)
4. Sortiranje po vise kolona

Često se javlja potreba da se izvrsi sortiranje po nekoliko kolona. To radite tako sto kliknete na Add Level i upišete drugi kriterijum sortiranja. Ovo omogućava da ukoliko imamo dva reda u tabeli, koji su po prvom kriterijumu sortiranja jednaki, drugim kriterijumom regulišemo koji će se naći ispred kog!

Filtriranje podataka
Filtriranje nam omogucava da lako izdvojimo podatke koji nam trebaju I samo njih analiziramo. Pre nego sto filtriramo podatke, opet je potrebno da ih sve oznacimo.
Podatke filtriramo tako sto kliknemo na Home  Sort&Filter  Filter. Zatim kliknemo na strelicu sa desne strane ćelije i zatim izaberemo Text Filter ispod koga se nalaze Check-box dugmici u kojim stikliramo reci koje zelimo da filtriramo. Zatim klikinemo na OK.
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Poništavanje filtera: Home  Sort&Filter  Clear
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3.6  (
na:
)Grafikoni
Napravimo tablicu u Excelu, npr. kao na slici:
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Dijagram (grafikon) je grafička prezentacija podataka koja treba da vizuelno istakne vrednosti iz tablice.
1. Obeležimo celu tablicu tako sto kliknemo u jedan od uglova tablice (i držimo pritisnut levi taster misa) i povučemo miš do drugog dijagonalnog ugla tablice. (strelica na slici pokazuje kako). Može se raditi i samo sa delom tablice, tada ćemo selektovati samo deo tablice koji želimo da prikažemo grafički.
2. Kliknimo na karticu Insert u meniju.
3. Kliknimo na Column (ili neki drugi tip grafika koji želimo da kreiramo - Column, Line, Pie, Bar, Area, Scatter...).
4. Kliknimo na željeni stil iz padajućeg menija (u ovom slučaju odaberemo prvi)
 (
I evo grafiko
)
(Ukoliko izaberemo opciju All Chart Types dobicemo jos neke vrste grafikona ili ukoliko
aktiviramo karticu Charts).


[image: ]

Kada napravimo tabelu možemo da vršimo izmene u njoj i samim tim se menja i grafik.
Desnim klikom miša na određeno mesto na grafikonu pojavljuje nam se lista u kojoj imamo mogućnost raznih izmena selektovanog područja.


Na primer, sa liste na kojoj imamo opciju "Format Chart Area" (slika gore levo) možemo promeniti izgled grafikona po želji, npr u 3D ili dodati senke (shadow) ili promeniti linije okvira itd. Promenom podataka u tablici baze podataka menja se i izgled na grafikonu.
Takodje podatke u grafikonu možemo menjati tako sto prvo kliknemo na grafik pa iz kartice
Design izaberemo Select Data.




Ako želimo da promenimo vrednost na Y- osi grafikona.
Na našem grafikonu minimalna vrednost je 0, a želimo da ta vrednost počne od 10 tada selektujemo vrednosti na Y- osi i iz liste izaberemo opciju Format Axis i selektujemo opciju Fixed i upišemo vrednost koju želimo da postavimo kao minimum. Nakon klika na close zatvaramo prozor i imamo izvršenu promenu minimalne vrednosti. (identicno ovo moze se uraditi ukoliko idemo na karticu format pa u levom uglu izaberemo opciju Format Selection).
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Ukoliko zelimo da zamenimo vrste i kolone kliknemo na Switch Row/Column.
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Takođe grafikon možemo, klikom i držanjem levog tastera miša, pomerati po radnom listu kao i kopirati na drugi radni list. (isto to možemo uraditi ukoliko kliknemo na grafik i onda u Design kartici odaberemo opciju Move Chart Location)
U Design kartici takodje mozete da menjate tip grafikona,raspored ,stilove i lokaciju.
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Da bismo izmenili oznake i nazive u grafiku kliknemo na grafik zatim u kartici Layout
izaberemo Chart Title ili Data Labels.
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[image: ]U kartici Layout nalaze se i opcije za ubacuivanje slika, možemo da menjamo oblike i polja za unos teksta, nalepnice, ose, pozadine itd...







Na kartici Format možete izmeniti oblik stilova, stilove reči i veličinu grafikona...
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4. Čas: Excel – nastavak
4.1 Formatiranje listova
Deljenje teksta u kolone

Ponekad ćete želeti da podelite podatke u jednoj, dve ili više ćelija. To možete učiniti lako koristeći
Convert Text to Columns Wizard.
· Označite kolonu kojoj želite da podelite podatke
· Kliknete na dugme Text to Columns na kartici Data
· Kliknete Delimited ako imate zarez ili karticu koja razdvaja podatke, ili kliknete na Fixed widths
da podesite razdvajanje podataka u određene veličine.
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Izmena fonta

Izmena fontova u Excel-u će vam omogućiti da naglasite naslove i podnaslove. Da biste promenili font:
· Izaberite jednu ili više ćelija kojima želite da promenite font
· Na kartici Home u grupi Font izaberite font type, size, bold, italics, underline, ili color
[image: ]

Formatiranje ćelija
U Excel-u, možete primeniti specifično formatiranje ćelija. Da biste to uradili:
· Izaberite jednu ili više ćelija koje želite da formatirate
· Kliknite na strelicu Dialog Box u grupi Alignment na kartici Home
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Postoji nekoliko kartica na ovom prozoru koje vam omogućavaju da menjate osobine ćelije ili ćelija:
· Number: Prikaz različitih tipova brojeva i decimala
· Alignment: Horizontalno i vertikalno poravnanje teksta, prelom teksta, skupljanje teksta, spajanje ćelija i pravac teksta
· Font: Omogućava kontrolu fonta, stil fonta, veličinu, boju i dodatne mogućnosti
· Border: Stilovi i boje ivica
· Fill: Boje i stilovi ćelija


Dodavanje ivica i boja u ćeliji
Ivice i boje mogu biti dodate ćelijama ručno ili upotrebom stilova. Da biste ručno dodali granice:
· Kliknite Borders radi otvaranja padajućeg menija u grupi Font na kartici Home
· Izaberite odgovarajuću ivicu
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Promena boja ručno
· Kliknite Fill radi otvaranja padajućeg menija u grupi Font na kartici Home
· Izaberite odgovarajuću boju
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Promena ivica i boja korišćenjem stilova
· Kliknite Cell Styles na kartici Home
· Odaberite stil ili kliknite New Cell Style
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Uslovno formatiranje
Opcija za uslovno formariranje se nalazi na: Home  Styles  Conditional Formatting
Da bismo primenili uslovno formatiranje na neki deo tabele, potrebno je uraditi sledeće:
· Označiti deo tabele na koji želimo da primenimo formatiranje
· Kliknuti na opciju Home  Styles  Conditional Formatting
· Izabrati željeni uslov. Neki od ponudjenih su:
· Vrednosti veće od zadate
· Vrednosti manje od zadate
· Itd. (slika ispod)
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Na primer, možemo sve vrednosti veće od 5 formatirati tako da im pozadina bude zelena:
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Promena širine kolone i visine reda

Da biste promenili širinu kolone ili visinu reda:
· Kliknite na dugme Format u grupi Cells na kartici Home
· Ručno podesite širinu i visinu tako što ćete kliknuti Column Width ili Row Hight
· Da biste koristili AutoFit kliknite AutoFit Column Width ili AutoFit Row Hight
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Sakrivanje ili otkrivanje redova i kolona

Da biste sakrili ili otkrili redove ili kolone:
· Izaberite red ili kolonu koju želite da sakrijete ili okrijete
· Kliknite na dugme Format u grupi Cells na kartici Home
· Kliknite Hide ili Unhide
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Spajanje ćelija

Da biste spojili ćelije izaberite ćelije koje želite da spojite i kliknite na dugme Merge & Center u grupi
Alignment na kartici Home. Četiri izbora za spajanje ćelija su:
· Merge & Center: Kombinuje ćelije i centrira sadržaj u novim većim ćelijama
· Merge Across: Kombinuje ćelije preko kolone bez centriranja sadržaja
· Merge Cells: Kombinuje ćelije u rasponu bez centriranja
· Unmerge Cells: Deli spojenu ćeliju
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Poravnjanje sadržaja ćelija

Da biste poravnali sadržaj ćelija, izaberite jednu ili više ćelija koje želite da uskladite i kliknite na neku od opcija u okviru grupe Alignment na kartici Home. Postoji nekoliko opcija za usklađivanje sadržaja ćelija:
· Top Align: Poravnjava tekst na vrh ćelije
· Middle Align: Poravnjava tekst između vrha i dna ćelije
· Botton Align: Poravnjava tekst na dno ćelije
· Align Text Left: Poravnjava tekst na levu stranu ćelije
· Center: Postavlja tekst na sredini ćelije
· Align Text Right: Poravnjava tekst na desnu stranu ćelije
· Decrease Indent: Povećava uvlačenje između leve granice i teksta
· Orientation: Okreće tekst dijagonalno ili vertikalno
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Formatiranje Worksheet-ova

Možete preimenovati Worksheet ili promenite boju kartica. Da biste preimenovali Worksheet:
· Otvorite list da bi ga preimenovali
· Kliknite na dugme Format na kartici Home
· Kliknite Rename Sheet
· Ukucajte novo ime
· Pritisnite Enter
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Da biste promenili boju kartice Worksheet-a:
· Otvorite list koji treba da se menja
· Kliknite na dugme Format na kartici Home
· Kliknite Tab Color
· Izaberite boju
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Dodavanje i brisanje Worksheet-ova

Da biste dodali Worksheet:
· Otvorite Workbook
· Kliknite na dugme Insert u grupi Cells na karici Home
· Kliknite Insert Sheet
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Da biste izbrisali Worksheet:
· Otvorite Workbook
· Kliknite na dugme Delete u grupi Cells na kartici Home

· Kliknite Delete Sheet
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Kopiranje i lepljenje Worksheet-ova

Da biste kopirali Worksheet:
· Kliknite na karticu Worksheet-a koji želite da kopirate
· Desni klik i izaberite Move ili Copy
· Odaberite željenu poziciju lista
· Kliknite na polje za potvrdu pored Create a Copy
· Kliknite OK
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Štampanje naslova

Funkcija za štampanje naslova vam omogućava da ponovite zaglavlja kolona i redova na početku svake nove stranice:
· Kliknite na karticu Page Layout
· Kliknite na dugme Print Titles
· U odeljku Print Titles kliknite na polje da biste izabrali redove/kolone
· Izaberite red ili kolonu
· Kliknite Select Row/Column Button
· Kliknite OK
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Kreiranje zaglavlja ili podnožja (Header or Footer)

Da biste kreirali zaglavlje ili podnožje:
· Kliknite na dugme Header & Footer na kartici Insert
· Otvoriće se nova kartica Desing
· Da biste se prebacili na zaglavlje ili podnožje kliknite Go to Header ili Go to Footer
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· Da biste uneli tekst unesite ga u zaglavlju ili podnožju
· Da biste uneli preprogramirane podatke kao što su brojevi stranice, datum, vreme, ime datoteke ili ime Worksheet-a, kliknite na odgovarajuće dugme
· Da biste promenili lokaciju podatka kliknite na željenu ćeliju
[image: ]

Postavljanje margina

Da biste podesili margine:
· Kliknite na dugme Margins na kartici Page Layout
· Izaberite jednu od ponuđenih opcija, ili
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· Kliknite Custom Margins
· Popunite polja da biste podesili margine
· Kliknite OK
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Promena orjentacije stranica

Da biste promenili orjentaciju stranice iz vertikalnog u horizontalni:
· Kliknite Orientation na kartici Page Layout
· Izaberite Portrait ili Landscape
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Prelazak na novu stranicu

Možete stručno podesiti prelazak na novu stranicu radi lakšeg očitavanja kada se odštampa list. Za postavljanje preloma stranice:
· Kliknite Breaks na kartici Page Layout
· Kliknite Insert Page Break
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Štampanje dela Worksheet-a

Postoji mogućnost da ćete želeti da odštampate samo deo Worksheet-a. To se postiže na sledeći način:
· Izaberite oblast koju želite da štampate
· Kliknite Print Area na kartici Page Layout
· Izaberite Print Area
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4.2. Podela lista, zamrzavanje i sakrivanje kolona i redova
Podela lista
Možemo podeliti list na više segmenata promenljive veličine radi boljeg pregleda delova lista. Da biste podelili list:
· Selektujte bilo koju ćeliju u centru lista koju želite da podelite
· Kliknite na Split dugme iz View sekcije
· Kada je izvršena podela, možete manipulisati svakim delom posebno

Zamrzavanje kolona i redova
Možete izabrati da poseban deo lista ostane nepomičan dok radite na ostalim delovima lista. Ovo vam omogućuju funkcijeFreeze Rows and Columns. Da bistezamrzli red ilikolonu :
· Kliknite na Freeze Panes dugme u View sekciji
· Ili označite segment koji želite da zamrznete, ili odaberite uobičajene opcije zamrzavanja leve kolone ili gornjeg reda
· Da biste odmrznuli, kliknite na Freeze Panes dugme
· Kliknite na Unfreeze




Sakrivanje listova
Da biste sakrili list:
· Selektujte jezičak lista koji želite da sakrijete
· Desni klik na taj deo
· Kliknite na Hide

Da biste otkrili list:
· Desni klik na bilo koji list
· Kliknite na Unhide
· Izaberite list koji želite da otkrijete


4.3 Validacija podataka

Validacija podataka je funkcija u programu Excel koja se koristi za definisanje ograničenja u vezi sa podacima koji mogu ili treba da budu uneti u ćeliju. Validacija podataka se koristi da bi se izbegle greške kod unosa podataka. Uz pomoć ove funkcije mogu da se definišu i upozorenja u slučaju unosa pogrešnih podataka. Takođe mogu da se definišu i uputstva koja pomažu kod unosa.

Postavljanje validacije na ćeliju
Prvo označimo ćeliju na koju želimo da postavimo validaciju. Potom kliknemo na tab Datai izaberemo opciju Data Validation. Otvoriće nam se prozor Data Validation. U delu Settings u listi Allow biće nam ponudjeni neki mogući formati koji se mogu uneti u našu ćeliju (celi brojevi, decimalni brojevi, datum, vreme...).
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Ograničavanje brojeva u određenom intervalu
Najjednostavniji primer za validaciju je ograničavanje brojeva u određenom intervalu. To znači da se u tu ćeliju može uneti samo ceo broj, bilo koji drugi podatak će biti greška.
Primer. Želimo da u ćeliju bude moguć samo unos celih brojeva od 1 do 5. Svaki drugi unet broj ili tekst je greška. Označimo ćeliju i primenimo prethodno. U listi Allow izaberemo opciju Whole number. U listi Data izaberemo between i zadamo minimum 1, maksimum 5.
U listi Data takodje umesto between (izmedju) možemo izabrati i opciju da uneti brojevi budu veći, manji ili jednaki od neke zadate konstante.




Poruke upozorenja na grešku
Ukoliko smo u ćeliju za koju je definisana validacija ukucali pogrešan broj ili tekst koji nije dozvoljen za unos u tu ćeliju Excel će nam pokazati poruku upozorenja da se desila greška i da takav unos nije moguć. Klikom na Cancel poruka nestaje, ćelija se briše i možemo da ispravimo grešku.
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Često ovakve poruke upozorenja nisu baš korisne. One nam govore da postoji zabrana unosa odredjenog teksta u ćeliju, ali ne govore zašto nije dozvoljen unos i šta treba upisati u tu ćeliju. Da bi sebi olakšali
rad, ove poruke možemo da modifikujemo tako da nam daju više obaveštenja. Poruke upozorenja modifikujemo na sledeći način: označimo ćeliju, potom
DataDataValidationError Alert. U delu Error Message ukucamo poruku koju želimo da nam Excel prikaže prilikom pogrešnog unosa. Npr. ukucamo: Dozvoljen unos celih brojeva od 1 do 5!
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U deli Style moguće su tri opcije:
-Stop (sprečava korisnika da pogrešan podatak u ćeliju)
-Warning (obaveštava korisnika da je uneti podatak pogrešan, ali ne sprečava unošenje. Opcijom Yes korisnik može da unese takav pogrešan podatak, a opcijom No je unos poništen)
-Information (radi isto što i Warning, razlika je sto je opcijom Ok dozvoljen pogrešan unos, a opcijom Cancel je poništen)



Rad bi nam bio mnogo lakši kada bi se poruka o validaciji prikazala pre unosa podataka i to klikom na
ćeliju. U prozoru Data Validation izaberemo Input Message.U belom kvadratu Input Message iskucamo poruku koju želimo da nam Excel prikaže pre kucanja podataka u odgovarajuće ćelije.
[image: ]
Klikom na ćeliju prikazuje se poruka koju želimo.
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Kopiranje validacije
Ukoliko želimo da postavimo istu validaciju u više ćelija, možemo da označimo željeni blok umesto jedne ćelije i da primeni isto postupak kao i za jednu ćeliju.
Takodje možemo i da postavimo validaciju na jednu ćeliju pa da je kopiramo u ostale. Desni klik na ćeliju čiju validaciju želimo da kopiramo i izaberemo Copy. Zatim desni klik na ćeliju ili blok ćelija u koji želimo

da kopiramo validacija i izaberemoPaste SpecialValidationOK. Ovako će se kopirati samo validacija. Ukoliko osim validacije želimo da kopiramo i unete podatke u ćeliji dovoljno je da nakon što smo kliknuli OK samo pritisnemo Enter.
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Pronalaženje ćelija sa validacijom
Ćelije u kojima je postavljena validacija nisu specijalno označene i često se desi da zaboravimo u kojoj smo tačno ćeliji postavili validaciju. Excel može da nam pokaže te ćelije na sledeći način:
Kliknemo na tab HomeFind & SelectData Validation. Excel će obojiti sve ćelije u kojima je postavljena validacija.
Ako želimo da proverimo da li još neka ćelija ima istu validaciju kao izabrana ćelija to radimo na sledeći način:
Kliknemo na ćeliju i izaberemo Find & SelectGo to SpecialData ValidationSameOK.
Ukoliko postoji ćelija sa istom validacijom Excel će je obojiti, a ako ne postoji izbaciće obaveštenje No cells were found (Nisu pronadjene ćelije).

Drugi primeri validacije

Ograničavanje ćelije za unos datuma
U listi Allow izaberemo opciju Date i unesemo opseg datuma (početni i krajnji datum). Ukoliko samo navedemo dan i mesec, Excel će za godinu automatski postaviti tekuću godinu. Za unos datuma možemo koristiti sve formate (1.1.2015, 1. Jan 2015, 1. Januar 2015).
Postavljanje liste
Ukoliko želimo da u ćeliji unesemo samo odredjene pojmove (podaci koji se često ponavljaju) u listi
Allow izaberemo opciju List. U delu Source otkucamo pojmove za koje želimo da se nadju u listi. Razdvajamo ih znakom ; (tačka zarez). U nekim slučajevima moguće je pojmove razdvojiti i samo zarezom. Vodimo računa da je obavezno čekirana opcija In-drop celldown i stisnemo OK. Pored naše ćelije će se pojaviti strelica i klikom na nju prikazaće nam se lista pojmova mogućih za unos. Klikom na
pojam on se pojavljuje u ćeliji. Izabrani pojam možemo promeniti u bilo kom trenutku ponovo klikom na

strelicu.


Ograničavanje broja karaktera
U listi Allow izaberemo opciju Text Lenght i navedemo od koliko karaktera se reč sastoji. Ukoliko ukucamo reč koja ima više ili manje karaktera Excel će prijaviti grešku.




PRILAGOĐENE VALIDACIJE
Može da se desi da nam je potrebna neka validacija koje nema ponudjene u listi Allow. Možemo napraviti sopstvenu validaciju na sledeći način:
U listi Allow izaberemo opciju Custom i u delu Formula zadamo (opišemo našu novu validaciju). Na primer ukoliko želimo da zbir brojeva unetih u ćelije A1, A2, A3, A4 bude manji od 100, selektovaćemo ćelije od A1 do A4 i na njih ćemo postaviti validaciju. U delu Formula upisaćemo
=SUM(A1:A4)<=100. Ukoliko unesemo brojeve 20, 30, 45, 60 Excel će izbaciti obaveštenje o grešci jer je zbir tih brojeva veći od 100.

5. Čas – Excel (nastavak)
5.1 Komentari

Excel ima veoma koristan alat koji vam omogućava da dodate objašnjenja za svaku ćeliju. To se može koristiti, na primer, da objasni šta posebna formula izračunava, ili da sačuvate dodatne informacije koje generalno ne bi trebalo da budu prikazane. Takođe, komentari su jako korisni ako Excel fajl deli više osoba u kancelariji - svaki korisnik dodaje komentar da obavesti ostale o načinjenim promenama.

Dodavanje komentara ćeliji
Prvo označimo ćeliju na koju želimo da postavimo komentar. Potom kliknemo na tab Review i odaberemo opciju NewComment. Pored ćelije će se otvoriti prostor za unos komentara.
Drugi način za postavljanje komentara je da označimo ćeliju na koju želimo postaviti komentar, zatim kliknemo desni klik i odaberemo opciju Insert Comment.

Prikaz komentara
U kartici Review se nalaze neke opcije za komentare:
· Edit Comment-promena sadržaja komentara
· Delete-brisanje komentara
· Previous,Next-prikazuje prethodni,sledeći komentar
· Show/Hide Comment-za prikaz/skrivanje određenog komentara
· Show All Comments-prikazuje/skriva sve komentare

Opcije Edit Comment, Delete Comment i Hide/Show možete naći i u padajućem meniju koji se otvara desnim klikom na ćeliju.
Takođe, brisanje komentara možete izvršiti označavanjem ćelije → Home → Editing → Clear → Clear Comments.
[image: ]Excel dozvoljava da tražite informaciju koja se nalazi u komentaru koristeći opciju Find, tj. Home → Find & Select → Find i otvoriće se prozor Find and Replace. Isto ćete postići pritiskom Ctrl+f. Unesite tekst koji tražite u polje Find what, a potom Options → Look in i odaberite opciju Comments. Zatim kliknite na Find Next ili Find All.

Formatiranje komentara
Komentar je moguće formatirati isto kao i tekst. Za formatiranje komentara, selektujte ga, a potom koristite opcije iz Home tab-a. Ili, drugi način je da se pozicionirate na okvir komentara, desni klik i Format Comment- pojaviće se prozor za formatiranje.
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Još neke opcije sa komentarima
U Excel-u postoji opcija kojom se indikator na komentar ćelije skriva. Označite ćeliju sa komentarom, kliknete na Office Button → Excel Options → Advanced → Display → No comments or indicators.
Takođe, možete promeniti User name(tekst koji se pojavljuje pri umetanju novog komentara); Office Button → Excel Options → Popular → User name → <unesete tekst> → OK.
Standardno, pri štampanju Excel dokumenta, komentari se ne štampaju. Moguće je podesiti štampanje
[image: ]komentara na kraju strane ili na njihovoj poziciji u tekstu:
Page Layout → Page Setup → Sheet → Comments → At end of sheet/As displayed on sheet. Klikom na Print Preview možete videti kako će izgledati dokument kada se odštampa.

5.2 Datum i vreme
Uvod

Iako Microsoft Excel ispisuje datum i vreme na očekivan način, u stvari ih čuva kao brojeve. Datumi se čuvaju kao broj dana od početka prošlog veka(tj. 1.1.1900. je prvi dan) Neki sistemi(eg Apple Macs) koriste 1.1.1904. kao prvi dan, i u Excel-u postoji opcija koja prihvata ovo. Datume pre 1900.-te godine Excel pamti kao tekst i njih ne mozete koristiti u računanju. Vremena se čuvaju kao delovi jednog  dana,tj. podne se pamti kao ½.

Formatiranje datuma i vremena
Excel prihvata različite formate unosa datuma u ćeliju (godina/mesec/dan , kao i dan/mesec/godina). Mesece možete uneti kao broj ili tekst (ime meseca ili skraćeni oblik). Za godine između 1930. i 2029. možete unositi samo poslednje 2 cifre,i Excel će prepoznati koja je godina. Ako je godina izostavljena pretposvalja se da je tekuća godina u pitanju.Za razdvajanje dana,meseca i godine koristi se / ili - . Prilikom unosa vremena u ćeliju koristimo : za razdvajanje sata,minuta i sekunde. Pošto vreme predstavlja deo dana , sat uvek mora da se unese.Vreme možete uneti i sa sufksima AM/PM. Ako se uneti podaci za datum i vreme nalaze na desnoj strani ćelije,to žnači da ih je Excel prepoznao baš kao datum i vreme , a ako se nalaze sa leve strane,Excel ih onda smatra tekstualnim podacima.
[image: ][image: ]

Kada ste uneli datum ili vreme u ćeliju,različiti formati i stilovi se mogu primeniti na unete podatke.

· Ukoliko želite da unesete današnji datum pritisnite <Ctrl;> a za unos trenutnog vremena pritisnite <Ctrl:>
· U okviru Home-a, postoji grupa Number, ukoliko želite da se prikaže ceo datum izaberite opciju LongDate. Slično,postoji opcija More Number Formats gde možete da izaberete opcije vezane za datum i vreme ali i neke druge.
· Format u kome zelite da zapišete datum ili vreme moze se prilagoditi,ukoliko vam je potreban format koji nije ugrađen u sistem, na sledeći način Number Format → More Number Formats → Type. U polju Type unesite npr. h "hours" m "minutes" s.00 "seconds".
Dan,mesec,godinu kao i sat,minut i sekund u Excel možete uneti na sledeći način :
· d (Dani kao 1-31) , dd (kao 01-31 dana) , ddd(Fri-Sun) , dddd(Monday-Friday)
· m(Meseci kao 1-12), mm(01-12 meseci), mmm(Jan-Dec), mmmm(January-December), mmmmm(J,F,.	D)
· y ili yy(kao 00-99 godina) , yyy(godian kao 2000.)

· h i hh(0-23 i 00-23 sati)
· m i mm(0-59 ili 00-59 minuta)
· ss(0-59 ili 00-59 sekundi)

Funkcije za datum i vreme

Pošto datume i vreme Excel čuva kao brojeve,oni se mogu koristiti u nekim izračunavanjima- na primer lako je odrediti broj dana između dva datuma,ili da izračunate zarade zaposlenog po satu. Ako radite sa istorijskim podacima(Pre 1900) i želite da sprovedete bilo kakva računanja onda možete ili da ga čuvate kao post-1900 ili da koristite funkcije za izračunavanje ekvivalentnog datuma koji je posle 1900.

· Funkcije za unos današnjeg datuma i trenutnog vremena su NOW i TODAY [(=NOW() , =TODAY()] U narednim funkcijama vrednost za datum/vreme moze biti ili u oblku teksta ili broj :
· DAY(datum)  - izdvaja dan u mesecu od datuma ,npr DAY(NOW()) .
· MONTH(datum) -  izdvaja mesec od datuma, npr MONTH(NOW()) .
· YEAR(datum) - izdvaja godinu od datuma ,npr YEAR(NOW()) .
· HOUR(vreme) - izdvaja sat iz vremena ,npr HOUR(NOW()).
· MINUTE(vreme)- izdvaja minut iz vremena, npr MINUTE(NOW()) .
· SECOND(vreme)- izdvaja sekund iz vremena, npr SECOND(NOW()).

Datume i vreme možete čuvati i kao tekst,ali se tada podaci ne mogu koristiti za izračunavanja.Na primer funkcija TEXT(NOW(),"dddd") će prikazati današnji dan ali kao tekst, ili funkcija TEXT(NOW(),"h:mm") će prikazati trenutno vreme.

· DATE(godina,mesec,dan)- prevodi zasebne brojeve u datum( datum kao broj). TIME(sat,minut,sekund) - prevodi zasebne brojeve u vreme (vreme kao broj).
· DATEVALUE("datum") - prevodi datum zapisan u tekst formatu u broj.
· TIMEVALUE("vreme") - kao DATEVALUE ali za vreme.
· WEEKDAY(datum) - broj dana u nedelji.(Sun=1 ako ne postavimo drugačije).
· WEEKNUM(datum)- broj nedelje od početka godine
· WORKDAY(datum,broj)- broj radnih dana nakon određenog datuma.

5.3. Razne funkcije
Uvod
Funkcije u Excel-u imaju ustanovljenu strukturu, prvo se navodi ime funkcije, a zatim, u zagradama, njeni argumenti razdvojeni zarezima. Excel obezbeđuje preko 300 različitih funkcija koje pokrivaju širok spektar potreba ( industrija, trgovina, finansije. ).

Unošenje funkcije
Svaka formula mora početi znakom jednakosti, a zatim sledi račun. Funkcije se mogu pisati direktno ili upotrebom dugmeta [Insert Function].
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Paleta Formula
Paleta Formula može biti od velike pomći, posebno za funkcije koje su manje poznate. Omogućava smernice o korišćenju svake funkcije i njenih argumenata. Ukoliko se kao argument unese tekst ili neki logički karakteri, ignorisaće ih. Ukoliko vam je potrebna dodatna pomoć i primeri korišćenja funkcije, pomoć se nalazi u donjem levom uglu prozora. U podnožju palete, pojavljuje se rezultat formule.

Često korišćene funkcije
Upoznaćemo se sa najčešće korišćenim funkcijama. U okviru kartice Formulas nalaze se funkcije podeljene u različite kategorije: finansijske , za datum i vreme, matematičke i trigonometrijske, statističke, informacije i tekst. Takođe možete da kreirate svoju funkciju.
Da biste videli listu svih funkcija, u okviru dugmeta [Insert Function] , klikom na strelicu, možete dobiti listu svih ponuđenih funkcija. Za pomoć oko rada sa funkcijom, u donjem levom uglu nalazi se opcija Help.

Primer 
U excel-u napraviti tabelu koja sadrži sledeće podatke: naziv robe, proizvođač, cena, datum proizvodnje.

	Naziv robe
	Proizvodjac
	Cena (DIN)
	Datum proizvodnje
	Nova cena

	DVD
	SAMSUNG
	13322
	6-Nov-14
	

	DVD
	SAMSUNG
	8677
	6-Mar-15
	

	DVD
	SONY
	19870
	5-Apr-13
	

	DVD
	SAMSUNG
	15743
	9-Oct-15
	

	FRIZIDER
	BEKO
	11245
	6-Jul-15
	

	FRIZIDER
	GORENJE
	5464
	5-Apr-14
	

	FRIZIDER
	GORENJE
	6444
	11-Sep-14
	

	TV
	SAMSUNG
	29874
	6-Apr-09
	

	TV
	SONY
	32000
	23-Feb-01
	

	TV
	SONY
	25644
	4-Dec-15
	

	TV
	SONY
	64321
	4-Mar-13
	



Statističke funkcije
· COUNT – prebrojava ćelije koje sadrže brojeve,
· COUNTA – prebrojava ćelije koje sadrže bilo koji tip informacija,
· COUNTBLANK – govori koliko je praznih ćelija,
· COUNTIF – koliko ćelija zadovoljava određeni kriterijum,
· DCOUNT , DCOUNTA – dve specijalizovane funkcije.

Primer 
1. Kliknite na ćeliju u kojoj želite da smestite rezultat funkcije,
2. Kliknite na karticu Formulas, zatim na strelicu ispod dugmeta AutoSum i izaberite Count Numbers,
3. U okviru argumenta funkcije navedite ćelije za koje vršite prebrojavanje, npr. c2:c6, kao rezultat dobićete broj 5,
4. Ukoliko u okviru argumenta navedemo ćelije čiji je sadržaj tekst, npr. kolonu Proizvođač, kao rezultat dobićemo 0,
5. Dok je ćelija selektovana, pritisnemo <F2> i promenimo COUNT u COUNTA, kao rezultat funkcije, dobićemo sve neprazne ćelije, a ukoliko stavimo COUNTBLANCK, dobićemo broj praznih ćelija.

Logičke funkcije
· IF – zadaje logički uslov koji treba da se ispita, takođe koristimo i funkcije SUMIF I COUNTIF,
· AND – daje vrednost TRUE ako su svi argumenti tačni
· OR – daje vrednost TRUE ako je bilo koji od argumenata tačan
· NOT – zadaje suprotnu logičku vrednost argument ( negacija )

Primer IF 
1. Dodajte novu kolonu pod nazivom Nova Cena
2. U ćeliji E2 ukucajte =IF(
3. Argumenti : Za Logical_test postaviti a2=“DVD” – rezultat je FALSE Za Value_if_true postaviti na c2
Za Velue_if_false postaviti c2*115%
4. Očekujemo da gde god je Naziv robe različit od DVD, cena je uvećana za 15%.



Primer COUNTIF 
1. Kliknite na ćeliju F2 i ukucajte FRIZIDER
2. Na G2 ukucajte =countif( [Insetr Function] dugme za argumente
3. Postavite Range na a2:a12 i Criteria na ''FRIZIDER'' (tekst obavezno navoditi između navodnika)
4. Dobićete da tri ćelije sadrže ''FRIZIDER''

Primer SUMIF 
1. U H2 ukucajte =SUMIF ( [Insert Function] dugme za argumente
2. Postavite Range na a2:a12, Criteria na F2, a Sum_range na c2:c12
3. Kao rezultat dobija se ukupna cena ''FRIZIDER''
4. Za ukupnu cenu ostalih artikala, dovoljno je promeniti Criteria i postaviti naziv odredjene robe

Primer AND, OR i NOT 
1. Kliknite na ćeliju u koju želite da smestite rezultat
2. Ukucajte =AND ( [Insert Function] za argumente
3. Postaviti Logical1 na B2=''GORENJE'' i Logical2 na A2=''TV''
4. Kako je prvi argument netačan (FALSE), a drugi tačan (TRUE), rezultat funkcije je FALSE
5. Umesto funkcije AND ukucati OR i kao rezultat ćemo dobiti TRUE.

Ugnježdene funkcije
Jedna funkcija se može koristiti unutar druge. Takve funkcije su ugnježdene.
1. Selektujemo ćeliju i ukucamo =NOT(OR(B2=’’GORENJE’’, A2=’’TV’’))
2. Pritisnite <Enter>

U logičkim funkcijama SUMIF i COUNTIF ne možete koristiti ugnježdene funkcije
3. Ukoliko  želimo  da prebrojimo sve ćelije koje ne sadrže  DVD, ukucajte	=countif( a2:a6, NOT(''DVD'')), rezultat formule je 0, što nije tacno.

4. Kliknite na [Insert Function] dugme i videcete poruku za gresku #VALUE u okviru argumenta Criteria
5. Ovo mozete resiti tako sto ukucate u Criteria ''<>DVD'', zato sto brojite tekst, tako da i Criteria mora biti u obliku teksta
6. U slucaju kada su ugnjezdenje funkcije komplikovane, mozete ih razdvojiti u vise delova.

Filtriranje i SUBTOTAL funkcija
Umeto funkcije SUMIF, možemo koristit funkcije filtriranja i SUBTOTAL funkciju, koje daju isti rezultat.
1. Pritisnite <Ctrl Home> i u okviru kartice Home, pritisnite dugme Sort&Filter i izaberite Filter
2. Kliknite na celiju A2 i na kartici View odaberite [Freeze Panes] i selektujemo Freeze Top Row
3. Kliknite na strelicu A1 iskljucite Select All i izaberite FRIZIDER
4. Na celiji u kojoj zelite da smestite rezultat kliknite na [AutoSum] dugme, pojaviće se funkcija SUBTOTAL(9, c5:c8), pritisnite <Enter>
5. Kriterijume mozete menjati u zavisnosti od izbora Naziv robe i Proizvodjac

U okviru funkcije SUBTOTAL nalazi se Help on this function i u okviru njega možemo primetiti da Function_num uzima različite vrednosti.
6. Promenite Function_num iz 9 u 4, pritisnite <Enter> i dobicete MAX vrednost
7. Takodje, mozete izracunati i MIN, AVERAGE…

Matematičke funkcije
· ABS – daje apsolutnu vrednost broja
· INT – zaokružuju broj na najbliži manji ceo broj. Druge slične funkcije su CEILING( zaokružuje broj na najbliži ceo broj) i FLOOR( zaokružuje broj na nižu vrednost).
· ROUND – zaokružuje broj na zadati broj cifara, takodje ROUNDUP ( zaokružuje broj na višu vrednost), ROUNDDOWN (zaokružuje broj na nižu vrednost) i  TRUNC ( skraćuje broj na ceo  broj )
· RAND – daje nasumični broj između 0 i 1, takodje RANDBETWEEN ( daje nasumični broj između zadatih brojeva )
· PI – daje vrednost borja pi.
1. Prebacite se na praznu starnicu Sheet
2. U A2 ukucajte =int( rand () *100), ugnježdena funkcija rand() daje slučajne, cele brojeve izmedju 0 i 99
3. U A3 ukucajte =randbetween(0,99) – daje istu vrednost kao i prethodni korak, ali ja lakša za upotrebu

Funkcije datuma i vremena
· TODAY – daje trenutni datum
· NOW – daje trenutni datum i vreme
· YEAR / MONTH / DAY / HOUR / MINUTE / SECOND – konvertuje redni broj u godinu / mesec / dan / čas / minut / sekundu redom
· 	DAYS360 – računa broj dana između dva datuma, pri čemu treba voditi računa o načinu unošenja datuma ( oblika “25/12/1980” ili “25 Dec 1980”, pomoću funkcije DATE ili kao rezultat druge funkcije ili formule )

Primer 
1. U B1 ukucajte =today() , kliknite <Enter> i kao rezultat, dobićete trenutni datum
2. Da dobijete samo vreme, ukucajte =now();
3. Da otkrijete koliko je dana prošlo od vaseg rođenja, ukucajte =days360(“vaš datum rođenja”, now()).
Lakši način da ukucate današnji datum u ćeliju je upotrebom <Ctrl ;>, dok <Ctrl : > vam daje tačno vreme.

Funkcije teksta
Takođe postoji i nekoliko funkcija za rad sa tekstom.
1. LEN – broji karaktere uključujući i razmake
2. FIND – pronalazi jednu tekstualnu vrednost unutar druge
3. LEFT / MID / RIGHT – izabrati deo teksta sa leve / srednje / desne strane
4. LOWER / UPPER / PROPER – konvertuje tekst u mala / velika / mešoviti slučaj
5. EXACT – poredi sadržaj dve ćelije da vide da li su isti
6. TRIM – uklanja razmake iz teksta
7. SUBSTITUTE – zamenjuje stari tekst novim u tekstualnoj niski
8. CHAR – daje znak određen kodnim brojem
9. CODE – daje numerički kod prvog znaka tekstualne niske
10. TEXT – oblikuje broj I konvertuje ga u tekst
11. VALUE – konvertuje tekstualni argument u broj

Primer 
1. U ćeliji C1 ukucajte svoje ime i prezime
2. U ćeliji C2 ukucajte =len(c1) – dobićete dužinu imena uključujući i razmak
3. U ćeliji C3 ukucajte =find('' '' ,c1,1 ) – pronalazi razmak između reči

4. U ćeliji C4 ukucajte =left(c1,c3-1) – dobijate samo prvu reč

5. U ćeliju C5 ukucajte =mid(c1,c3+1,2) – dobijate prezime

6. U ćeliji C6 ukucajte =upper(c1) – pretvara mala slova u velika

7. U ćeliji C7 ukucajte =proper(c6) – pretvara velika slova u mala ne racunajuci prvo slovo

8. U ćeliji C8 ukucajte =excat(c7, c6)

9. U ćeliji C9 ukucajte =code(''a'') – a ima numericku vrednost 97

10. U ćeliji C10 ukucajte =char(98) – dobijamo slovo b

11. U ćeliji C11 ukucajte = 32.5&char(176) – dodaje znak stepena

12. Ukucajte = TEXT(CODE(''a''), ''#''), broj je konvertovan u tekst, a ako ukucamo = VALUE(c9) suma je ponovo 97
TEXT funkcija moze biti jako korisna i moćna

1. Ukucajte = TEXT( [Insert Function] dugme

2. U Value ukucajte now() a u Format_text ukucajte ''dddd'', razultat pokazuje koji je dan u nedelji

3. Kliknite na [Number Format] dugme i odaberite More Number Formats zatim Custom i vidite koji su formati na raspolaganju
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